
English language Competencies

Term Learning Outcome Competencies Topic/Chapter Assessment SDG 
By the end of each unit 
students will be able to:

Term 1

identify and rearrange jumbled 
words to form meaningful 
sentences, demonstrating an 
understanding of basic sentence 
structure and correct grammar 
usage; enhance vocabulary, 
apply punctuation and 
capitalisation accurately

Rearrange jumbled words 
into grammatically correct 
sentences using logical 
reasoning and context. 
Recognise and apply 
grammar rules, including 
subject-verb agreement and 
punctuation (capital letters, 
full stop and question 
mark), to form coherent 
sentences. Engage in 
collaborative learning 
activities to solve 
sentences.

Sentences and Punctuation

Mid-term 1

No Poverty, 
Zero 
Hunger, 
Good 
Health, 
Quality 
Education, 
Gender 
Inequality, 
Clean Water 
and 
Sanitation, 
Responsible 
Consumptio
n, Life 
below 
Water, Life 
on Land

understand the correct use of 
articles (a, an, the) in sentences, 
recognising their role in 
specifying nouns; identify when 
to use indefinite articles (a, an) 
and definite articles (the) 
appropriately based on context 
and pronunciation rules

Apply the rules of using 
articles by distinguishing 
between general and 
specific references in 
sentences. Demonstrate the 
ability to choose between 
‘a, an, and the’ based on 
noun type (singular/plural) 
and vowel/consonant 
sounds.

Articles (a, an, the)

identify and differentiate 
between common nouns 
(general names) and proper 
nouns (specific names) in 
sentences; understand the 
importance of capitalising 
proper nouns and using nouns 
appropriately to enhance clarity 
and meaning in communication

Classify nouns as common 
or proper based on their 
usage in context. Apply the 
rule of capitalisation for 
proper nouns.

Nouns (Common and 
Proper)

express ideas clearly through 
sentence construction activities; 
write and speak effectively by 
organising thoughts in a logical 
sequence, presenting opinions 
and recounting personal 
experiences

Construct coherent 
sentences using their 
knowledge of grammar to 
express opinions.

Sentence Construction

identify and categorise nouns 
based on gender: masculine, 
feminine, common and neuter; 
understand the concept of 
gender in nouns and use them 
accurately in sentences, 
enhancing their ability to 
communicate effectively

Classify nouns into 
masculine, feminine, 
common and neuter 
genders based on their 
meaning and usage.

Gender (masculine, 
feminine, common, 

neuter)

Half-yearly

No Poverty, 
Zero 
Hunger, 
Good 
Health, 
Quality 
Education, 
Gender 
Inequality, 
Clean Water 
and 
Sanitation, 
Responsible 
Consumptio
n, Life 
below 
Water, Life 
on Land

identify and differentiate 
between countable and 
uncountable nouns, as well as 
singular and plural forms of 
nouns; understand the rules for 
forming plurals and the correct 
usage of quantifiers with 
countable and uncountable 
nouns, enabling them to 
construct grammatically 
accurate sentences

Classify nouns as countable 
or uncountable and use 
appropriate quantifiers (e.
g., some, many, much) for 
each type. Form singular 
and plural nouns correctly, 
applying spelling rules 
where necessary and use 
them in sentences.

Countable and 
Uncountable Nouns, 

Singular- Plural

identify and use collective 
nouns to refer to groups of 
people, animals or things as a 
single entity

Recognise collective nouns 
in texts and construct 
sentences using them 
appropriately.

Collective Nouns

identify and use pronouns such 
as he, she, it, they, we, you, I, 
this, that, these, and those in 
place of nouns to avoid 
repetition and enhance clarity

Apply appropriate 
pronouns based on gender, 
number and proximity (e.g., 
this and that for singular, 
these and those for plural).

Pronouns - He, she , It, 
they, we, you, I, this, that, 

these, those



Term 1

express ideas clearly through 
composition, comprehension 
and sentence construction 
activities; write and speak 
effectively by organising 
thoughts in a logical sequence, 
presenting opinions, recounting 
personal experiences and 
sequencing events in a story or 
paragraph

Construct coherent 
sentences and paragraphs 
to express opinions, 
sequence a story logically 
and share personal 
experiences with clarity. 
Demonstrate 
comprehension skills by 
understanding texts and 
answering questions based 
on the content.

Composition and 
Comprehension

Half-yearly

No Poverty, 
Zero 
Hunger, 
Good 
Health, 
Quality 
Education, 
Gender 
Inequality, 
Clean Water 
and 
Sanitation, 
Responsible 
Consumptio
n, Life 
below 
Water, Life 
on Land

Term 2 identify and use verbs (action 
words) and helping verbs (am, 
is, are, was, were, has, have, 
had) to construct meaningful 
and grammatically correct 
sentences; understand the role 
of verbs in indicating actions, 
states or possession and the 
importance of helping verbs in 
forming tenses and moods; 
understand and use the Simple 
Present, Simple Past and Simple 
Future Tenses to describe 
actions or events in the correct 
time frame; recognise the usage 
of these tenses to communicate 
effectively in speaking and 
writing

Recognise and apply verbs 
in sentences to describe 
actions or states effectively. 
Use helping verbs correctly 
in conjunction with main 
verbs to indicate time, 
tense or subject-verb 
agreement. Construct 
sentences using the Simple 
Present tense for habitual 
actions and general truths, 
the Simple Past tense for 
completed actions and the 
Simple Future tense to 
describe upcoming events. 
Apply the correct verb 
forms and time indicators 
(e.g., yesterday, today, 
tomorrow) in context.

Verbs, Helping Verbs and 
Tenses (Simple Present, 
Simple Past and Simple 

Future)

Mid-term 2

No Poverty, 
Zero 
Hunger, 
Good 
Health, 
Quality 
Education, 
Gender 
Inequality, 
Clean Water 
and 
Sanitation, 
Responsible 
Consumptio
n, Life 
below 
Water, Life 
on Land

identify and use adjectives of 
quality, number and comparison 
to describe nouns effectively; 
understand how adjectives 
enhance the meaning of 
sentences by providing 
additional details about objects, 
people or situations

Apply adjectives of quality 
to describe characteristics 
(e.g., beautiful, tall), 
adjectives of number to 
indicate quantity (e.g., two, 
many) and adjectives of 
comparison to compare two 
or more entities (e.g., taller, 
tallest).

Adjectives

identifiy and use prepositions to 
show the relationship between 
nouns or pronouns and other 
words in a sentence; understand 
how prepositions express 
direction, location, time and 
manner, helping to clarify the 
meaning of sentences

Use prepositions (e.g., in, 
on, under, between, beside, 
before, after) correctly in 
sentences to indicate 
relationships of place, time 
and direction.

Prepositions (in, on, under, 
between, before, after, at)

identify and use conjunctions 
(and, but, because, or) to 
connect words, phrases or 
clauses in sentences; 
understand how conjunctions 
help create compound and 
complex sentences, improving 
the flow and clarity of 
communication

Apply conjunctions to join 
ideas or sentences (e.g., 
and for addition, but for 
contrast, because for 
reason, or for choice). 
Demonstrate the ability to 
construct sentences with 
conjunctions to express 
relationships between ideas 
clearly.

Conjunctions(and,but,
because,or)

express ideas clearly through 
composition, comprehension 
and sentence construction 
activities; write and speak 
effectively by organising 
thoughts in a logical sequence, 
presenting opinions, recounting 
personal experiences and 
sequencing events in a story or 
paragraph

Construct coherent 
sentences and paragraphs 
to express opinions, 
sequence a story logically 
and share personal 
experiences with clarity. 
Demonstrate 
comprehension skills by 
understanding texts and 
answering questions based 
on the content.

Sentence Construction, 
Opinions, Composition, 

Comprehension



Term 2

All the competencies 
covered in the academic 
year.

Recapitulation Final 

No Poverty, 
Zero 
Hunger, 
Good 
Health, 
Quality 
Education, 
Gender 
Inequality, 
Clean Water 
and 
Sanitation, 
Responsible 
Consumptio
n, Life 
below 
Water, Life 
on Land

Mathematics Competencies
Term Learning Outcome Competencies Topic/Chapter Assessment SDG 

By the end of each unit students 
will be able to:

Term 1

form, read and understand 
numbers upto 9999, compare 
and order 4-digit numbers

Write numbers and number 
names correctly and 
compare numbers using 
appropriate symbols (>, <, 
=). Arrange numbers 
systematically in ascending 
(smallest to largest) and 
descending (largest to 
smallest) order.

Numbers (1-9999), 
Number Names, Greater 
than, Less than, Equal to, 

Ascending and Descending 
Order

Mid-term 1

form the greatest and smallest 
four-digit numbers using given 
digits, apply logical reasoning to 
arrange digits in ascending and 
descending order to construct 
the desired numbers without 
repetition

Identify and arrange digits 
to form the greatest and 
smallest four-digit numbers 
(e.g., for digits 5, 2, 8, 0: 
greatest = 8520, smallest = 
2058).

Formation of greatest and 
smallest number with 4 

digits

solve simple daily life problems 
using addition of four digit 
numbers with and without 
regrouping, sums not exceeding 
9999

Solve simple daily life 
problems using addition 
with and without 
regrouping.

Addition and Addition 
Story Sums

No Poverty, 
Zero 
Hunger, 
Good 
Health and 
Well-being, 
Quality 
Education, 
Responsible 
Consumptio
n, Life 
below 
Water, Life 
on Land

understand the concept of place 
value and identify the value of 
each digit in a number based on 
its position (ones, tens, 
hundreds, thousands), use this 
understanding to read, write 
and compare numbers 
accurately

Identify the place value of 
digits in numbers up to four 
digits and apply this 
knowledge to expand 
numbers (e.g., 2345 = 2000 
+ 300 + 40 + 5).

Place Value

understand and practice skip 
counting by 2, 3, 4, 5, and 10 
using a number line, recognise 
skip counting as a foundation 
for multiplication and patterns 
in numbers, enhancing their 
numerical fluency and problem-
solving skills

Use a number line to 
perform skip counting by 2, 
3, 4, 5, and 10, to mark and 
identify the sequence of 
numbers (e.g., 2, 4, 6, 8 for 
skip counting by 2). Relate 
skip counting to 
multiplication and apply it 
to solve problems and 
identify patterns.

Skip Counting (2,3,4,5,10) 
and Tables(6,7,8,9)

Half-yearly 



recognise 2D shapes like straight 
and curved lines; identify and 
make 2D shapes by paper 
folding, paper cutting on the dot 
grid, using straight lines; 
describe 2D shapes by counting 
their sides, corners and 
diagonals; fill a given region 
leaving no gaps using a tile of a 
given shape and forms various 
shapes using tangram pieces; 
develop the skill of identifying 
corners, edges and faces of solid 
shapes

Demonstrate the ability to 
recognise, compare and 
describe the properties of 
2D shapes (e.g., circles, 
squares, triangles) and 3D 
shapes (e.g., cubes, 
spheres, cones). Apply their 
understanding by relating 
shapes to real-life objects.

Shapes and Tangrams
Half-yearly 

solve simple daily life problems 
using subtraction of four digit 
numbers with and without 
regrouping, answer not 
exceeding 9999

Solve simple daily life 
problems using subtraction 
with and without 
regrouping.

Subtraction and 
Subtraction Story Sums

No Poverty, 
Zero 
Hunger, 
Clean Water 
and 
Sanitation, 
Climate 
Action, 
Good 
Health, 
Gender 
Equality, 
Quality 
Education, 
Responsible 
Consumptio
n, Life 
below 
Water, Life 
on Land

recall and apply multiplication 
facts to solve problems 
accurately; understand the 
concept of repeated addition 
and its relationship to 
multiplication

Understand and use 
multiplication facts to solve 
multiplication problems 
efficiently.

Multiplication (3 digit by 1 
or 2 digit) and 

Multiplication Story Sums

Term Learning Outcome Competencies Topic/Chapter Assessment SDG 

Term 2 understand and apply the 
concepts of short and long 
division to divide two- and 
three-digit numbers by a one-
digit divisor without 
remainders; develop the ability 
to perform division accurately 
and interpret its relationship 
with multiplication; explain thr 
meaning of division facts by 
equal grouping or sharing and 
find it by repeated subtraction

Demonstrate the ability to 
divide two and three digit 
numbers by one-digit 
divisor using both short and 
long division methods. Use 
this method to divide items 
equally or and to find out 
the remainder.

Division and Division Story 
Sums

Mid-term 2 

No Poverty, 
Zero 
Hunger, 
Good 
Health, 
Gender 
Equality, 
Quality 
Education, 
Responsible 
Consumptio
n, Life 
below 
Water, Life 
on Land

understand the concept of 
money, including buying and 
selling, handling simple bills and 
using simple rate charts; add 
and subtract small amounts of 
money with or without 
regrouping

Demonstrate the ability to 
calculate prices, make 
simple purchases and 
manage transactions using 
money. Solve problems 
involving addition and 
subtraction of small 
amounts of money, 
interpret simple bills and 
rate charts and practice 
budgeting.

Money

estimate and measure length 
and distance using standard 
units like centimetres or metres; 
weigh objects using simple 
balance; compare the capacity 
of different containers in terms 
of non uniform units

Demonstrate the ability to 
measure length, weight and 
capacity using both non-
standard units (e.g., paper 
clips, blocks) and standard 
units (cm, m, g, kg). 
Compare and convert units 
of measurement, 
recognising the relationship 
between cm and m, and g 
and kg.

Measurement

identify and create patterns 
using simple shapes, recognising 
repeating sequences and 
relationships; understand the 
concept of tessellation and 
apply it by arranging shapes to 
cover a surface without gaps or 
overlaps

Demonstrate the ability to 
identify, create and extend 
patterns using basic shapes 
(e.g., circles, squares, 
triangles). Apply their 
understanding of 
tessellation by arranging 
shapes in a way that covers 
an area without leaving 
spaces.

Pattern and Tessellation



Term 2

understand the concept of data 
handling and collect, organise 
and represent data using 
pictographs and tally marks; 
interpret and analyse simple 
data to draw conclusions

Demonstrate the ability to 
collect and organise data, 
represent it using tally 
marks and pictographs and 
interpret the information 
presented.

Data Handling - Pictogram 
and Tally

Mid-term 2 

No Poverty, 
Zero 
Hunger, 
Good 
Health, 
Gender 
Equality, 
Quality 
Education, 
Responsible 
Consumptio
n, Life 
below 
Water, Life 
on Land

develop the ability to identify 
dates on a calendar and read 
time by the hour on an analog 
clock; understand the concept 
of days, months and time, and 
apply them in real-life contexts, 
use am and pm to tell time, 
convert 12 hours clock to 24 
hours clock

Demonstrate the ability to 
read and identify specific 
dates on a calendar and tell 
time by the hour using an 
analog clock, tell time using 
am and pm, convert time 
from 12 hour to 24 hour 
clock time. Understand and 
relate days of the week, 
months of the year and the 
passage of time in daily 
activities.

Time and Calendar

Final

No Poverty, 
Zero 
Hunger, 
Good 
Health, 
Gender 
Equality, 
Quality 
Education, 
Responsible 
Consumptio
n, Life 
below 
Water, Life 
on Land

All the competencies taught 
in the academic session.

Recapitulation

Mental Math to be done 
on a daily basis.

EVS Competencies
Term Learning Outcome Competencies Topic/Chapter Assessment SDG 

Term 1 explain what family is and why 
are family members important 
for us; identify amd compare 
nuclear, joint and single parent 
families

identify relationships and 
roles within families; 
understand ones own role 
in a family; learn about 
family tree

All About Families

Mid-term 1

Gender 
Equality; 
Peace, 
Justice and 
Strong 
Institutions

identify and name family 
members and describe their 
roles; explain the importance of 
family in their lives; share 
experiences about family 
activities and traditions and 
demonstrate respect and care 
towards family members

understand the concept of 
family and its members; 
recognise relationships and 
roles within the family; 
develop a sense of respect, 
care and cooperation

My Family

classify animals based on their 
types (wild, domestic, pet); 
describe their habitats and food 
habits; understand the 
importance of animals in the 
ecosystem

learn to differentiate 
between wild, domestic and 
pet animals, understand 
their habitats and food 
habits; develop an 
awareness of the 
interdependence between 
humans and animals

Animals - Our Friends
Life on Land

learn about food that we eat; 
understand the importance of 
fresh food; learn about cultural 
diversity in food; demonstrate 
good food habits; understand 
the importance of food chain

identify healthy food from 
unhealthy; make simple 
healthy food on their own; 
identify food that has got 
spoilt; avoid wasting food

Wonderful World of Food

Zero 
Hunger, 
Good 
Health

recognise and name common 
animals, birds and insects seen 
in our surroundings; draw 
pictures; understand the 
concept of endangered animals; 
understand and learn the 
lifecycle of a butterfly

enhance their observation 
and classification skills by 
identifying animals, birds 
and insects; develop an 
appreciation for the role of 
animals and insects in daily 
life and their importance in 
the environment

Animals Around Us

Half-yearly 

Life on Land

identify types of plants (trees, 
shrubs, herbs, climbers, 
creepers) and label parts of 
plants like roots, stems, leaves, 
flowers and fruits; 

enhance their observation 
and classification skills by 
identifying types of plants 
and understanding their 
parts and functions; 
develop an appreciation for 
the role of plants in daily 
life and their importance in 
the environment

Plants Around Us



demonstrate plant care 
methods through activities like 
planting seeds and observing 
germination; 

understand the benefits of 
plants for humans and 
animals; observe their role 
in the environment, and 
promote awareness about 
tree conservation; 
appreciate the relationship 
between plants and human 
life 

Plants - Our Green Friends

Half-yearly 

Life on Land

identify local, indoor and 
outdoor games; explain the 
importance of playing games for 
health and happiness; recognise 
raditional games played in their 
families or communities; 
demonstrate teamwork, fair 
play and active participation in 
group games and activities 
while sharing their experiences

understand the importance 
of games, recognising 
traditional and modern 
games; learning values such 
as teamwork, cooperation 
and fair play; develop a 
sense of physical well-being 
and the joy of participation

Games We Play

Good 
Health, 
Gender 
Equality

Term 2
identify daily habits that 
maintain cleanliness; 
understand the importance of 
eating healthy food and 
exercising regularly; 
demonstrate safety rules; 
identify their safe circle

develop personal hygiene 
habits; understand the 
importance of a balanced 
diet and exercise; learn 
ways to stay safe and 
healthy; gain practical 
knowledge about taking 
care of their physical and 
mental well-being

Caring for Self

Mid-term 2

Good 
Health, 
Responsible 
Consumptio
n

understand ways to be sensitive 
towards people in need; 
demonstrate acts of kindness 
such as helping, sharing or being 
polite; share personal 
experiences of helping others; 
explain the importance of being 
kind and role-play real-life 
situations to demonstrate their 
understanding of caring for 
others

develop empathy and 
understanding for others; 
learn to help elders, friends 
and animals; promote 
kindness and sharing; 
cultivate positive values of 
compassion and helpfulness

Caring for Others

Good 
Health; No 
Poverty; 
Reduced 
Inequality; 
Peace, 
Justice and 
Strong 
Institutions

show sensitivity for plants, 
animals, the elderly, differently 
abled and diverse family set 
ups; take care of self in 
emergency situations; learn 
about safety and protection

equip themselves for 
emergency situations; show 
kindness towards animals, 
birds and other humans 
who are different from 
them; keep the 
surroundings clean

Being Sensitive and 
Responsible

Reduced 
Inequality; 
Peace, 
Justice and 
Strong 
Institutions; 
Zero 
Hunger; No 
Poverty; 
Gender 
Equality; 
Quality 
Education

identify sources of water; 
explain its uses and understand 
the importance of clean water 
for health and daily activities; 
describe ways to conserve water

develop awareness about 
the importance of water; 
identify its sources; learn 
about water conservation; 
enhance critical thinking 
skills by understanding the 
need to save and use water 
wisely

Water and Us

Life on 
Land, Life 
below 
Water; 
Clean Water 
and 
Sanitation; 
Good 
Health; 
Climate 
Action

identify types of shelters and 
explain their importance; 
describe the materials used to 
build houses and share 
observations about different 
kinds of shelters in their 
surroundings

learn about different types 
of shelters, their features 
and their importance; 
develop observation and 
classification skills by 
identifying various types of 
houses and their materials

Shelters Around Us

Final

Sustainable 
Cities and 
Communitie
s; 
Responsible 
Consumptio
n



identify various modes of travel 
(land, water, air), describe their 
uses and understand the 
importance of transportation; 
share experiences about 
travelling and participate in 
activities like creating drawings 
or models of different vehicles

develop an understanding 
of modes of travel, their 
importance and their 
impact on human life; 
enhance their 
communication and 
observation skills while 
identifying the use of 
transport in daily life

Travel

Final

Good Jobs 
and 
Economic 
Growth, 
Responsible 
Consumptio
n

describe various means of 
communication, such as; 
understand their importance; 
share examples of 
communication in their lives

develop an understanding 
of communication methods, 
including traditional and 
modern means; enhance 
their observation and 
critical thinking skills by 
identifying the role of 
communication in daily life

Communication

Sustainable 
Cities and 
Communitie
s; 
Responsible 
Consumptio
n; Quality 
Education

identify directions (North, 
South, East, West), understand 
the use of landmarks and 
interpret simple maps or 
symbols; demonstrate their 
learning through activities like 
drawing simple maps or locating 
places on charts

develop map-reading and 
observation skills while 
learning about directions, 
landmarks and symbols; 
enhance their critical 
thinking skills by 
understanding the 
importance of locating 
places in real life

Locating Places

Bengali Competencies
Terms Learning Outcomes Competency Topic Assessment SDG



Term 1

Term 2

1࿹ ভাষার দ໐তা ও 
আ໳িব࿇࿡ ােসর িবকাশ࿻
༝বণ ও 
ব
ক
◌্তৃতা࿻ ࿎প༟ভােব ັশানার࿺ বুেঝ ັনয়ার ও আ໳িব࿇࿡ ােসর সােথ মতামত ࿭ྐྵ কােশর স໐মতা່
সংলাপ ও আেলাচনার দ໐তা࿻ 
গ࿆࿠ ࿺ কিবতা বা অন࿵ান࿵ 
পাঠ࿵সাম ࿭ྠ ཷর আেলাচনার 
মাধ࿵েম পার࿎পিরক িবিনময়࿺ 

࿭ྐྵ ࿇࿞  করা ও উ໱র ࿭ྐྵ দান່

2࿹ পাঠ࿵পু࿑࿱ ক ও সািহিত࿵ক 
কৃিতে ࿤ྭ র সােথ পিরিচিত࿻
পাঠ দ໐তা࿻ সহজ࿺ ັবাধগম࿵ 
পাঠ࿵সাম
গ
◌্রীর সহায়তায় শ༊াথྍ࿺ বাক࿵ গঠন ও পিরভাষার সমৃি໶່
সািহিত࿵ক সমেঝাতা࿻ গ࿆࿠ ࿺ 
কিবতা ও ັলাককথার মাধ࿵েম 
সাং
স
◌্কৃিতক ঐিতহ࿶ ও মূল࿵েবাধ িশখন࿺ পাঠ࿵ ও পাঠ࿵সূিচর মধ࿵ব১࿹ ༝বণ ও ব໌ৃতা দ໐তা

3࿹ ັলখন দ໐তার িবকাশ࿻
সཉক বণྍ࿺ শ༊ ও বাক࿵ গঠন࿻ 
࿎প༟ ও সহজ ັলখনী࿺ বণྍমালা࿺ 
উ໘ারণ ও ັমৗསলক ব࿵াকরেণ 
দ໐তা່
সৃজনশཷলতা ও 
ভাব
প
◌্রকাশ࿻ ࿏࿣ ࿆࿠ সািহত࿵࿺ ব࿵ি໌গত অিভໟতা ও ক࿆࿠ নাশি໌ কােজ লািগেয় সংས໐༃ রচনা࿺ িচཉ বা িববৃিতর ັলখন່

4࿹ সামি ࿭ྠ ক ভাষাগত ও 
সামািজক দ໐তা࿻
ັমৗিখক ও སলিখত ভাষার 
সম
ন
◌্বয়࿻ ༝বণ࿺ কথা বলা࿺ পড়া ও ັলখা চারཬট িদেকর ভারসাম࿵পূণྍ উླ࿞ য়ন່
সৃজনশཷল িচྶ࿱ া ও 
সমােলাচনামূলক িব྅࿇࿳ ষণ࿻ 
পাঠ࿵িভি໱ক ࿭ྐྵ ে࿇࿞ া໱র࿺ সহজ 
সমােলাচনামূলক িচྶ࿱ া ও যুি໌ 
িবকােশর মাধ࿵েম সমস࿵ার 
সমাধান এবং অিভໟতার 
সম ࿡ླ য়່

5࿹অྶ࿱ ভྍོি໌মূলক ও ࿭ྐྵ াসি໖ক 
িশ໐াদান࿻
িশ໐াথཷྏ র 
আ
গ
◌্রহ ও ࿭ྐྵ াকৃিতক িজໟাসােক কােজ লািগেয় পাঠদান࿻ পাঠ࿵໏েম ࿏࿛ ানীয় ও সাং༣ৃিতক উপাদােনর ব࿵বহার࿺ যা িশ໐াথཷྏ েদর ࿏࿣ ত༺ পিরচয় ও সাং༣ৃিতক ັগৗরেবর অনুভཱྀিত জািগেয় ັতােল່
ইྴটােরཬ໋ভ ও উপেভাগ࿵ িশ໐া 
প໶িত࿻ গ࿆࿠ ࿺ নাটক࿺ গােনর 
মাধ࿵েম ັশখার ࿭ྐྵ ি໏য়ােক 
আকষྍণཷয় কের ັতালা່

পাঠƟব˥র ĺবাধগমƟতা: 
ছাƯছাƯীরা সহজ বাংলা গɤ, 
কিবতা ও Ƶবȴ পেড় তার 
মলূ ভাব ও তথƟ বঝুেত 
পারেব।

ƽবণ ও বǏৃতা দǘতা: সহজ 
বাংলা বাকƟ ও কেথাপকথন 
˝েন তার অথŪ অনধুাবন 
করেত এবং ˰তঃʌূতŪ ভােব 
িনেজর ভাবনা ও অিভǷতা 
Ƶকাশ করেত পারেব।

ĺলখন দǘতা: ছাƯছাƯীরা 
সহজ ও সংিǘȼ বােকƟ 
িনেজর িচȭা, অনভূুিত ও 
অিভǷতা িলখেত সǘম হেব
।

শɆভাȉার বিৃȝ: Ƶিতিদেনর 
জীবেন বƟব˲ত সাধারণ 
বাংলা শɆ ও তােদর অথŪ 
জানেত এবং সǇকভােব 
Ƶেয়াগ করেত পারেব।

বƟাকরণ Ƿান: বাংলা ভাষার 
ĺমৗিলক বƟাকরিণক িনয়ম, 
ĺযমন িলǩ, সংখƟা, িƠয়া ও 
িবেশষেণর Ƶেয়াগ সɑেকŪ  
Ƶাথিমক ধারণা অজŪ ন করেব
।

এেলােমেলা শɆ সািজেয় বাকƟ 
ĺলখা, িবপরীত শɆ, সমাথŪক 
শɆ, িকছু গɤ, িকছু কিবতা 

িবেশষƟ, বচন, সেমাǮািরত 
িভȵাথŪক শɆ, অনেুǱদ, 
িকছু গɤ, িকছু কিবতা।

িবেশষণ, অবƟয়, িলǩ, 
িকছু গɤ, িকছু কিবতা।

িƠয়া ও িƠয়ার কাল, িলǩ, 
সেমাǮািরত িভȵাথŪক শɆ, 
অনেুǱদ, 
িকছু গɤ, িকছু কিবতা।

Mid Term 1

Half Yearly Exam 

Mid Term 2

Final Term Exam

Goal 6 Clean 
water and 
sanitation 

goal : 15 Use 
of Land

Goal 10 
Reduce 
inequalities 

Goal 12 
climate action

Hindi Competencies
TERM LEARNING OUTCOMES COMPETENCIES TOPICS ASSESSMENT SDG

वण[माला  को पहचान  कर åयविèथत  ढंग से ͧलख  सकɅ गे।  कͪवता  का वाचन  भाव  के साथ  करɅगे।  वण[ और वण[माला  

1 से 25 तक कȧ ͬगनती  शÞदɉ  और अ¢रɉ  मɅ  ͧलख  सकɅ गे।  कãपना  शिÈत  कȧ सहायता  से नई कहानी  कȧ रचना  करɅगे।  माğाएँ goal 1  No poverty 

ͩकसी  भी सं£ा  शÞदɉ  से ͧलगं  पहचान  कर उसका  ͧलगं  बदलने  मɅ  स¢म  हɉगे।आसपास  कȧ चीजɉ  को देखकर  उसके  बारे  मɅ  बोलȣ  Goal 2: Zero Hunger

पाठ  को पढ़कर  पूछे गए Ĥæनɉ  के उƣर  Ǒदखने  मɅ  स¢म  हɉगे।  अपने  भाव  åयÈत  कर सकते  हɇ। शÞद  और वाÈय                       MID TERM 1

अपने  ͪवɮयालय  और आसपास  कȧ चीज  हंू के बारे  नए शÞदɉ  को सुनकर  उसे वाÈय  कȧ रचना  करɅगे।ͧलगं  ,वचन , ͪवलोम  शÞद , समानाथȸ  शÞद  



 मɅ  संͯ¢Üत  जानकारȣ  देने मɅ  स¢म  हɉगे। अनुÍछेद  कͪवताएँ , कहाǓनयाँ  

कͪवता  याद  करके  ͧलखसकɅ गे। अपǑठत  गɮयांश  

ͬगनती  1-25
MID TERM 1

वाÈय  मɅ  सं£ा  शÞद  को चुनकर  बतासकɅ गे।  काåय  वाचन  मɅ  स¢म  हɉगे।  सं£ा  Goal 10 Reduce inequalities 

सं£ा  के èथान  पर ĤयुÈत  होने  वाले  शÞदɉ  कोपहचानɅगे।  भाव  और अͧभåयिÈत  के साथ  कहानी  सुनाएंगे।  सव[नाम  Goal 12 climate action 

एक से अनेक  मɅ  बदल  सकɅ गे।  वाÈय  मɅ  मुहावरɉ  का Ĥयोग  करɅगे।  वचन  

एक शÞद  के अनेक  अथɟ  का £ान  होगा।  लंबे वाÈय  के èथान  पर एक शÞद  का Ĥयोग  करɅगे।  अनेकाथȸ  शÞद , मुहावरे , पया[यवाची  शÞद                   HALF YEARLY 

मुहावरɉ  का अथ[ बता  सकɅ गे।  कͪवता  सुनकर  उसके  भाव  को समझ  कर समझाएंगे।  कͪवता , कहाǓनयाँ , अनुÍछेद  

पाठ  पढ़कर  Ĥæनɉ  का उƣर  देने मɅ  स¢म  हɉगे।  1 से 100 तक कȧ ͬगनती  याद  करɅगे  और समझɅगेअपǑठत  गɮयांश , समानाथȸ  शÞद  

कͪवता  याद  कर क¢ा  मɅ  ͧलखɅगे।  ͬगनती  26-50

कहानी  पढ़कर  èवयं  कहानी  रचना  करने  कȧ कोͧशश  करɅगे।

1-70 तक कȧ ͬगनती  शÞदɉ  मɅ  ͧलखɅगे। ͬगनती  Ǒहदंȣ  मɅ  समझɅगे  और åयवहार  मɅ  लɅगे।  ͪवशेषण  Goal 3 Good health 

वाÈय  मɅ  ͪवशेषता  वाले  शÞद  चुन सकɅ गे।  ͪवशेषता  वाले  शÞदɉ  को पहचान  कर उनका  Ĥयोग  करɅगे।  ͧलगं , वचन , समानाथȸ  शÞद , अनेकाथȸ  शÞद  Goal 6: quality education 

सं£ा  शÞदɉ  के ͧलगं  को पहचान  सकɅ गे।  अनेक  अथɟ  वाले  शÞद  को उपयुÈत  èथान  पर अनेक  शÞदɉ  के ͧलए  एक शÞद ,  मुहावरे

एक वचन  को बहुवचन  मɅ  बदल  सकɅ गे।  åयवहार  मɅ  लाएंगे। अशुɮͬध  शोधन  

शÞदɉ  का अथ[ समझकर  उसका  ͪवपरȣत  बता  सकɅ गे।  उͬचत  भाव  और अͧभåयिÈत  के साथ  काåय  सुनाएंगे।कͪवताएँ ,कहाǓनयाँ , अनुÍछेद                    MIDTERM 2

पाठ  पढ़कर  उनसे  पूछे गए Ĥæनɉ  के उƣर  देसकɅ गे।कहानी  को सुनकर  समझकर  उसका  भावाथ[  समझाएंगे।  अपǑठत  गɮयांश  

जीवन  मɅ  पेड़ पौधɉ  के माता  को समझɅगे।ͬगनती  50-70
MID TERM 2

1 से 100 तक ͬगनती  शÞदɉ  मɅ  ͧलखने  मɅ  स¢म  हɉगे।  Ǒहदंȣ  अंको  को åयवहार  मɅ  लɅगे।  ͩĐया  

वाÈय  मɅ  आए ͩĐया  शÞदɉ  को पहचानɅगे  और उनका  Ĥयोग  करɅगे।  यथाèथान  मुहावरɉ  का åयवहार  करɅगे।  वचन  Goal 6 Clean water and

उपयुÈत  èथान  पर उपयुÈत  मुहावरɉ  का Ĥयोग  करɅगे।  अͧभåयिÈत  के साथ  काåय  वाचन  करɅगे।  ͧलगं , वचन , समानाथȸ  शÞद , अनेकाथȸ  शÞद  sanitation 

पाठ  को पढ़कर  पूछे गए Ĥæनɉ  का उƣर  दɅगे। अͧभåयिÈत  के साथ  कथा  वाचन  करɅगे।  अनेक  शÞदɉ  के ͧलए  एक शÞद ,  मुहावरे                  FINAL goal : 15 

कͪवता  वाचन  करɅगे।  पाठ  को पढ़कर  उसके  ͪवषय  मɅ  अपनी  अͧभåयिÈत  दɅगे।अशुɮͬध  शोधन  Use of Land

èवÍछता  और पया[वरण  के ͪवषय  मɅ  अपने  भाव  åयÈत  करɅगे।अशुɮध  और शुɮध  वाÈय  के बीच  अंतर  समझ  मɅ  समझɅगे।  कͪवताएँ ,कहाǓनयाँ , अनुÍछेद  

अपने  आसपास  देखे जाने  वालȣ  चीजɉ  के बारे  मɅ  अपने  भाव  åयÈत  करɅगेअपǑठत  गɮयांश  

ͬगनती  71-100

Computer Competencies
Term Learning Outcome Competencies Topic/Chapter Assessments SDG
Term 1 Identify nd name common hardware 

parts and parts inside the CPU
Understanding the concept of a 
computer system.                                                                                                                                                                        
Knowing that the computer 
system works together as a unit 
(hardware, software, and user 
input/output).                                                                                     
Identifying major hardware 
components.                                                                                                                                                       
Recognizing peripheral devices: 
Such as speakers, scanners, and 
external storage devices (USB 
drives, etc.).                                                                           
Knowing that software is the set 
of instructions that tells the 
hardware what to do.
Identifying types of software.                                                                                                                                                                                                              
Understanding that without 
software, the hardware cannot do 
anything.                                                                                                                                                                                                                                                                    

Introduction to Computers Mid Term 1                                                               
SDG 4: Quality 
Education                       Differentiate between system software 

and application software
Differentiate between hardware and 
software
Know the names of popular softwares
Beable to say what is input, processing 
and output
List the categoriesof hardware
Define operrating system.                                                                                                                    
Locate and define the components of 
desktop.                                                       
Locate and define Taskbar.                                                                      
Use gadgets and Calculator.                                                                      
Know thw advantages of Windows.                                                                              
Know about touchscreen computers.                                                                
Change the position of taskbar.                     

Understanding MS Windows as an 
Operating System.                                                                                                                                    
Recognizing Windows 7 as a 
version of MS Windows.                                                                                                                                       
Recognizing the desktop screen.                                                                                                                                                                                  
Identifying the desktop 
background.                                                                                                                                                                           
Understanding what icons are.                                                                                                                                                                                
Identifying common desktop 
icons.                                                                                                   
Recognizing the taskbar. 
Identifying key areas of the 
taskbar.                                                                                                                              
Defining gadgets: Knowing that 
gadgets are small programs on 
the desktop that show useful 
information like the clock, 
weather, or calendar.                                                                                                                                      
Knowing how to open the 
calculator and perform basic 
calculations.                      
Using gadgets: Learning how to 
add, move, and close gadgets on 
the desktop.                                                        

Learn to Use MS Windows 7 Half Yearly



Term 1

Identify the commands in Tools and 
Shapes group on the Ribbon.                                                                                                     
Use brush, text, color, curve and 
polygon.                                                                       
Use Rectangular and Free form 
selection.                                          
Differentiate between Copy Paste and 
Cut Paste.

Opening Paint: Learning how to 
open Microsoft Paint from the 
Start menu or taskbar.                                                                                          
Identifying key sections of the 
Ribbon:
Home Tab: Where most of the 
drawing and editing tools are 
found.
View Tab: To zoom in or out of the 
canvas.                                                                                                                                                                        
Using icons on the Ribbon: 
Learning to click icons to select 
different tools (e.g., pencil, brush, 
shape tools).                                                                                              
Drawing a Picture in Paint.                                                                                                                                                                                             
Using the Home Tab in Paint.                                                                                                                                                                                             
Cut, Copy, and Paste: Learning 
how to cut, copy, and paste parts 
of the image to move or duplicate 
them.          

More on Paint

Half Yearly

                                                              
SDG 4: Quality 
Education                       

Term 2 Define word processor.                                                              
Start MS Word 2010.                                                              
Create a document.                                                         
Insert a blank line.                                         
Format the text.                                      
List the features of a word processor.                                   
Recall the keys of a keyboard.                                
Save, Open, Print, and close the 
document.

Understanding Word Processing: 
Recognizing that Microsoft Word 
is a program used for typing, 
editing, and formatting text.                                                                                        
Starting a New Document.
Opening Microsoft Word 2010: 
Learning how to open Microsoft 
Word 2010 from the Start menu or 
taskbar.                                                                                                     
Identifying the main parts of the 
Word window, such as the ribbon, 
toolbar, scroll bar, and status bar.                                                                                
Learning to type letters, numbers, 
and special characters correctly.
Entering Text into the Document: 
Typing simple words, sentences, 
and paragraphs into the blank 
document.                                                                           
Saving the Document for the First 
Time: Learning how to save a new 
document by clicking on File > 
Save As and selecting a location 
on the computer to save the file.
Naming the Document: Giving the 
document a name and selecting 
the file format (usually .docx).
Saving Changes: Knowing how to 
save any changes made to the 
document by clicking File > Save 
or using the shortcut Ctrl + S.                                                                      
Understanding how to print the 
document by clicking the Print 
button in the File menu.                                                                                    
Learning how to close a document 
by clicking File > Close or clicking 
the X in the upper-right corner.                                     

Learn to use Microsoft Word 
2010

Mid Term 2 SDG 5: Gender 
Equality                                                              
SDG 4: Quality 
Education                                                     
SDG 3: Good 
Health and 
Well Being

Define Network, computer network and 
internet.                                                                         
Define internet terms like website, 
webpage etc.                                         
Name different web browsers.                                                
List the uses of Internet.

Knowing that the internet is a 
global network that connects 
millions of computers, allowing 
people to share information, 
communicate, and access 
resources.                                                                                                                                                                                                        
Understanding how the internet is 
used for various activities like 
education, entertainment, 
communication, and 
reRecognizing that a website is a 
collection of pages on the 
internet, like a virtual location 
where information is stored.
search.                                                                                
Understanding that a web browser 
(e.g., Google Chrome, Internet 
Explorer, Safari) is a program 
used to aUses of the 
Internetccess websites.                                                                    
Recognizing that an internet 
connection is the link between 
your computer and the internet, 
allowing you to access online 
resources.                                                  

Introduction to Internet Final Term

Define ICT                                                              
Relate computers to ICT                                                             
Recognise robots

Recognizing that ICT stands for 
Information and Communication 
Technology, which includes 
computers, the internet, and other 
devices used to communicate and 
store information.                                                            
Knowing that ICT helps in daily 
activities like learning, 
communicating, and accessing 
information.                                                                                      

More on ICT


